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Introduction

This book is a guide to preparing 

publications for commercial printing using 

Canvas 5 software. It also introduces general 

concepts and terms to help you better 

understand the publishing process.

Planning ahead is important for successful 

publishing. You can make decisions early in 

the process so problems don’t show up on the 

printing press, when they’re difficult and 

expensive to fix. Each section of this book 

includes questions about printing 

requirements and options that you might 

need to consider. 

To learn more, you can find hundreds of 

current volumes about the technical and 

creative aspects of print publishing. The 

Resources section lists some publications and 

information sources you might want to use. 

You can also find the latest information and 

step-by-step procedures in the on-line Help 

system in Canvas 5.
7





             
AN OVERVIEW OF PRINTING METHODS 

To understand the steps required to make a 
publication ready for printing, it helps to 
know about common printing methods and 
how printing presses operate. 

The best way to learn about different types of 
presses is to visit printing plants and see 
presses in operation. Ask about their 
capabilities. For example, how many colors 
and pages can be printed at once? What types 
of paper can be used on each type of press? 

Printing presses are based on four general 
printing methods — letterpress, gravure, 
lithography, and screen printing — which are 
described on the following pages. 

Particular types of printing presses are 
designed for various printing tasks.

• Sheet-fed presses print on separate 
sheets of paper, printing one complete 
page at a time, or one large sheet that 
will be cut into separate pages.

• Web presses print on a continuous sheet 
of paper threaded through the press from 
a roll. Web presses are used to print 
newspapers and other timely publica-
tions.

• A “perfecting” press can print on both 
sides of the paper at once.

• On older mechanical presses, operators 
must adjust ink flow, web tension, print-
ing plate alignment and other settings by 
hand.

• Modern presses have control systems 
that monitor printing and let the operator 
adjust the press with computerized pre-
cision.
9
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Lithography and offset printing

The term “lithography” is from the classical 
Greek words lithos (stone) and graphein, 
(writing). Today’s most widely-used 
printing method originated with the 1798 
discovery by a Bavarian playwright that 
stones could be used to print images. 

The playwright, Aloys Senefelder, drew a 
design with a greasy substance on a porous 
stone. He then spread a wetting solution on 
the stone, which dampened the blank areas. 
When Senefelder rolled a greasy ink onto 
the stone, the ink stuck to the design but not 
to the damp areas. By then pressing paper 
against the stone, Senefelder transferred the 
inked design to the paper and made the 
world’s first lithograph.

Today, printing presses based on 
lithography use flat metal or plastic printing 
plates that have a photosensitive emulsion 
surface. For printing, the plate is exposed 
against a negative film of the image to be 
printed. Developing the image and 
processing the plate changes the emulsion so 
only the image areas on the plate are 
receptive to ink; blank areas attract the 
wetting solution that flows over the plate on 
the printing press.

Offset lithography is the most common 
commercial printing process used today. 
The word “offset” refers to the press 

configuration. Rather 
than printing 
Magenta ink rollers

Wetting rollers

Impression roller

Offset roller

Printing plate

Offset press (two units)

Cyan ink rollers

Paper



     
directly from an inked plate onto paper, the 
inked image is offset (transferred) from the 
plate to a rubber-covered roller. When paper 
passes between the offset roller and an 
impression roller, it picks up the image.
11

Offset lithography step-by-step

The printing process begins with platemaking. An exposure 
is made with a film negative in contact with the photosensi-
tive emulsion on the plate. 

When the plate is processed, the film image becomes a 
positive image on the plate. The printing plate is mounted 
on a cylindrical drum on the press. 

Wetting: As the plate turns, a series of rollers apply a foun-
tain solution that wets the plate. Image areas repel the solu-
tion.

Inking: Another series of rollers applies ink to the plate. Ink 
adheres to the image, but the fountain solution prevents 
the ink from adhering to non-image areas on the plate.

Offsetting: As the inked plate turns, the image is transferred 
to a rubber blanket on the offset roller.

Printing: The image transfers from the offset roller to the 
paper. 

Platemaking

Wetting

Inking Offsetting Printing
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Letterpress

Letterpress uses a relief image — the design 
to be printed is raised above the surface of 
the printing plate — to transfer ink to paper, 
much like a rubber stamp. 

Letterpress is the world’s oldest printing 
method. Developed in ancient times and 
perfected over hundreds of years, it’s still in 
use for books, packaging, and specialty 
printing.

In letterpress printing’s long history, carved 
blocks of wood, type cast in metal, and 
molded plastics have been used to create the 
letterpress printing surface.

Historians trace the earliest development of 
type (individual letterforms) for letterpress 
printing to 1500 B.C. In China and Korea in 
the 13th century, type was being cast in 
metal. In 1440, Johann Gutenberg invented a 
system of letterpress printing with moveable 
metal type that led to the spread of printing 
throughout the Old and New worlds.

Flexography is a modern form of letterpress 
printing in which flexible rubber or plastic 
printing plates are used. Some modern 
applications rely on inkless letterpress 
techniques. These applications include 
effects such as embossing, hot foil stamping, 
and die cutting, in which raised forms make 
cutouts in paper and other products.



    

Screen printing

 

In screen printing, ink is pushed through a 
stencil onto the printed material. The stencil 
is attached to a fine mesh screen that is 
mounted in a frame. Because the screens 
were once made of silk, this printing method 
is now often called “silk screening.”

Stencils for screen printing were originally
cut by hand. Now the image to be printed is
exposed from a positive film onto a photo-
sensitive emulsion. After development, the
emulsion is applied to the screen and open ar-
eas around the edge are masked out. Special-
ized screen presses can print on bottles and
other curved surfaces. The ink used is thicker
than ink for other printing methods, which al-
lows screen presses to apply dense colors or
special finishes to wood, paper, cloth, leath-
er, wallpaper, metal, and glass.
Gravure

For the gravure method, an image is etched 
as tiny pits or wells in the surface of a 
cylindrical metal printing plate. As the plate 
rotates on the press, the wells pick up ink 
from a reservoir or ink roller. A flexible 
blade wipes away excess ink, and then the 
paper, pressed by an impression roller 
against the plate, picks up the image as 
thousands of tiny ink dots.

Gravure presses are used to print newspaper 
supplements, magazines, catalogs, stamps, 
and paper currency. Gravure plates are 
expensive to produce but durable enough to 
be used for printing a million impressions or 
more.
13
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Arranging publications for the press

Editors and designers look at a publication 
in “reader’s spreads,” with the pages in their 
normal sequence. This is the way Canvas 
displays publication documents (you can 
view facing-page spreads when you set up a 
two-sided publication with the Document 
Setup command). 

However, printing requires a different page 
arrangement for the press. To see this, look 
at the front page of a newspaper. The single 
sheet has Page 1 and the last page printed on 
one side, and Page 2 and the next-to-last 
page on the reverse, like a book cover.

Imposition is the process of putting a 
publication’s pages in proper order for 
printing. The term “stripping” is used to 
describe the arranging of film images to 
make printing plates. 

Presses are usually set up so four, eight, 16 
or more pages print together on one large 
piece of paper, a “press sheet.” A form is a 
set of pages arranged for printing on one 
side of a press sheet. After the forms on both 
sides are printed, the sheet is folded to make 
a signature, a set of printed pages in the right 
order for binding. 

Newsletters and pamphlets might be printed 
on one signature. For larger publications, 
additional signatures are printed. 

Though you might want to handle most 
other prepress tasks yourself, imposition is 
often done as part of the platemaking 
operation at the printing plant. 

If you need to output film negatives with 
pages already in press order, or produce 
printing plates directly from digital files, you 
might want to consider using the 
commercial imposition software now 
available. Imposition programs can handle a 
variety of publications and press 
configurations. However, most software 
requires you to take your publication file 
(such as a native Canvas document) and 
convert it to separate PostScript printer files 
for each page.

116134

6 11 10 7

215143

5 12 9 8

16-page signature (two 8-page forms)

Imposition charts show the arrangement of pages 
as they will be printed on both sides of a press 
sheet.



         
Finishing steps 

Once its pages are printed, a publication 
often goes through steps such as trimming, 
folding, binding, and packaging. 

Most newspapers are run on web presses 
that have finishing equipment such as slitters 
and folders attached to the press line. Books 
are usually printed and then finished on 
separate machines. Advertising pieces and 
catalogs might go from the press to 
computerized addressing and insertion 
equipment.

Folding a publication is designed to make 
pages ready for binding, or to shape the final 
printed piece. Folds can be made parallel to 
each other or at right angles. For example:

• A standard letter needs two parallel 
folds to fit in a business envelope. 

• Greeting cards and invitations often 
have two right-angle folds. 

• A one-sheet pamphlet can be folded 
into overlapping panels, or with accor-
dion folds like a road map.

For binding, folds are cut open or trimmed 
off, dividing the sheet into separate pages.

Two right-angle folds for 
invitations and cards

A single fold for a one-
sheet pamphlet

Two parallel folds for 
brochures and maps

Multiple parallel folds

Folded 16-page signature

Three parallel folds

Types of folds for publications

16
8
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Binding

Binding a publication can be as simple as 
putting pages in a notebook, or as elaborate 
as designing custom covers and hand-
applied decorations for keepsake and art 
publications.

Most books are saddle-stitched or perfect-
bound inside a cover. The following are 
some common binding methods.

Saddle stitching

This type of binding 
is used for booklets 
of 72 pages or less. 
Signatures are 
gathered together so 
the spines are all 
inside the first 
sheet. If a cover is included, it’s folded 
around the gathered signatures. A machine 
stitches the signatures and cover together 
with wire staples on the spine. This type of 
binding lets a booklet lie flat and is often 
used for pamphlets, programs, and catalogs.

Perfect binding

This is the common method of binding 
paperback books. The signatures are 
gathered one after the other, and then their 
backs are ground off to leave a rough 
surface. A flexible binding adhesive is 
applied to glue the signatures together, and 
then the cover is folded and glued in place 
around the book.

Edition binding

Edition binding is the traditional method of 
binding books between hard covers. This 
type of binding is expensive but long-
lasting, and it lets a book lie relatively flat. 
School textbooks, journals, and other 
hardcover volumes use edition binding.

Mechanical binding

Some mechanical 
binding systems allow 
new pages to be 
inserted. The simplest 
devices are loose-leaf 
notebooks that accept 
pre-punched pages. 
Other systems use plastic or wire spirals. For 
these bindings, the inner page margin must 
be wide enough for holes to be punched.



   
COLOR PRINTING AND IMAGE REPRODUCTION

When you create a color publication, the first 

thing to consider is the type of color you 

need. Do you want to print photographs and 

color images that require process colors? Do 

you want to use a few accent colors, or do 

you need to exactly match hues that can be 

printed only with spot colors? 

You can choose thousands of colors to use in 

printing, but you can print only one color at a 

time on the press. Printing full-color images 

requires sequentially printing several colors 

on the page.

This section explores methods of color 

printing, including the basics of color 

separation, knockouts, overprinting, and 

trapping.

The concepts of color printing are closely 

related to the issues involved in printing 

images such as photographs and artwork. 

Halftone screening, the process that lets a 

printing press print a photograph as a grid of 

dots, is also required to print thousands of 

colors using only three primary hues on the 

press. This section also introduces some 

basic concepts of image reproduction, 

including halftones, resolution, types of 

source images, and scanning.
17
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Halftone screening for images

If you look closely at a black and white 
newspaper photograph, you can see that the 
image is formed from thousands of tiny dots. 
If you magnify the image, you’ll see that the 
size of the black and white dots differs in the 
lighter and darker areas. This is the result of 
halftone screening, a process that converts a 
photograph into a dot pattern for printing.

Halftone screening is necessary to print 
images with a full range of tones — 
photographs, drawings, and artwork — 
because presses can print only solid colors. 
Though each halftone dot is a tiny spot of 
solid color, when we view a printed 
halftone, our minds merge the dots so we see 
the shading of the original image.

At one time, making halftones required 
photographing an original image through a 
glass pane etched with a fine grid pattern. 
Even though software now does the work of 
glass screens, it’s still common to say that 
images need to be “screened.” In both 
traditional and digital prepress, images must 
be made into halftones for the printing plate.

Halftone screen frequency

The dots in a halftone screen are arranged in 
a grid, with the size of the grid measured by 
the number of grid lines (the number of dots 
in a row) in one inch or centimeter. The 
measurement of lines per inch (abbreviated 
lpi) is the halftone screen frequency, also 
called the screen ruling, screen resolution, or 
line screen.

85 lpi 100 lpi

Comparing halftone screening 

A photograph printed at several screen frequencies shows that higher screen frequency 
results in a smoother image with smaller halftone dots...



          
A typical halftone screen frequency for 
newspapers is 65 to 85 lpi. For magazines 
printed on web offset presses, 133 lpi is 
typical. For high-quality publications, 
halftones are screened at 150 or 175 lpi and 
higher. Halftones in the Color Printing Guide 
are screened at 150 lpi.

To determine the best halftone screen 
frequency for your publications, ask your 
printer for recommendations. View the 
examples in this and other publications, 
especially those printed on the same type of 
press and paper you will use, to see the 
results of halftone screening.

• Images should be scanned (or created) 
with sufficient resolution for halftone 
screening. Using a higher screen fre-
quency requires higher resolution ima-
ges. See “Resolution of images and 
output devices,” next.

• The maximum screen frequency (and 
the quality of printed images) depends 
a lot on the paper used. Presses can 
print finer halftone patterns on coated 
paper than on rough newsprint.

• When you print proof copies or final 
film negatives from Canvas, you can 
select different screen resolutions to 
match the capabilities of devices for 
proofing and final output.

133 lpi 150 lpi

...but using high screen frequency requires more information (higher resolution) in the original 
digital image. Higher resolution results in larger image files and longer processing time.
19
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Resolution of images and output devices

It’s easy to confuse halftone screen 
frequency with the numbers used to describe 
the resolution of an output device, a scanner, 
or an image that has been scanned. 
Sometimes, the same term—dots per inch 
—is used to describe resolution and screen 
frequency. 

The output resolution of devices such as 
laser printers is the maximum number of 
dots the device can print in an inch (dots per 
inch, abbreviated dpi). The finer the 
resolution, the smaller the dots and the 
higher the dpi value. 

Resolution for digital scanners is measured 
as the number of dots (pixels) per inch that 
the scanner can capture. Higher resolution 
means the scanner captures more 
information in the same area. 

For digital images, resolution measures the 
size of the pixels that make up the image, 
expressed as pixels per inch (ppi). This 
applies to digital images from any source, 
whether scanned, created on computer, or 
captured by a digital camera.

The resolution of an image tells you how 
much digital information the image 
contains. Each pixel making up the image is 
a dot of solid color, and the smaller the 
pixels, the finer the image appears.

Scanning to create digital images

Original art can be turned into digital art by 
scanning. Art can be scanned with low-cost 
desktop scanners or on drum scanners that 
can capture very high-resolution images. 

Desktop scanners can be used to scan black-
and-white and color photographs, diagrams 
and other line art, and even small, flat 
objects. Desktop scanners can’t capture the 
same pixel information and tonal range as 
drum scanners, but they are much less 
expensive. 

With a desktop scanner, you can save money 
and control the scanning process. The trade-
off comes in image quality and the extra 
time that might be needed to color-correct 
the images.

Desktop scanner quality is sufficient to 
capture images for autotracing, photos “for 
position only” in layouts, and images to be 
printed at low or medium resolution. 

If you require high-quality digital images, a 
scanning service can use a high-end scanner 
to make digital files from your source 
images. If you use a service bureau for 



        
scanning, ask if they can also provide low-
resolution copies of the images for you to 
use in layouts.

Determining scanning resolution

The table at right can be used as a guide to 
determine the image resolution needed for 
reproduction at common halftone screen 
frequencies. 

Standard practice is to set image resolution 
to 1.5 or 2 times the halftone frequency 
(shown in the following table) when images 
will be printed at original size. However, 
even experts disagree on what is exactly the 
right ratio between resolution and screen 
frequency. 

You want to make sure an image contains 
enough pixel information, but you don’t 
want to use a higher resolution than 
necessary. 

 

Higher resolution results in larger images 
that take up more memory. Larger images 
make your document files larger, so they 
take longer to open, save, and print. Very 
large images can slow down processing and 
cause extra expense when you print 
separations on an imagesetter.

However, you might need to scan or create 
images at higher resolution if the images 
will be enlarged. In that case, use the final 
image size to calculate the required 
resolution based on the amount of pixel 
information needed. 

Screen 
frequency Ratio

Image 
resolution

65 lpi 1.5 100 ppi

2.0 130 

85 1.5 130

2 170

120 1.5 180

2 240

150 1.5 225

2 300
21
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Also, keep in mind that enlarging digital 
images requires Canvas to use a 
mathematical process called interpolation to 
create new pixels from the existing data. 
This can cause the image to lose sharpness.

Source images

Sources of images include photographs, 
paintings, pen-and-ink diagrams, pencil 
sketches, watercolors and other visual art. 
Original images can be physical (like a 
photographic print) or digital (a Photo CD 
image file). The following are general types 
of source images.

Reflective art is hard-copy material — 
photographic prints, paintings, and 
illustrations on paper. Transmission art is 
material such as color photographic slides 
and transparencies for overhead projectors. 
Both forms of original art can be scanned to 
be used in digital form.

Continuous-tone art contains a range of 
tones, as in a photograph, a painting, or a 
charcoal sketch. Because printing presses 
can only print solid colors, continuous-tone 
art must be screened for reproduction. 

Line art, such as an ink drawing that contains 
only two tones (black and white), can be 
reproduced without screening. However, 
when line art is scanned, it becomes a pixel-
based image. If it has variations in shade, it 
will become a screened halftone in color 
separations. If you want to preserve the solid 
appearance of line art, you can try 
autotracing the scanned image to create a 
vector illustration from it.

Digital art exists on a computer system. It 
can be stored in a standard file format, such 
as TIFF, or in the proprietary file format 
created by Canvas or other graphics 
software. Digital art either originates on the 
computer, or is scanned from hard-copy 
original material.

Original digital art can be vector or raster art 
created in Canvas (or other programs). For 
process printing, be sure that digital art 
contains process colors (CMYK). RGB 
colors won’t be reproduced accurately with 
CMYK inks on the press.



Image resolution and memory requirements

This table shows the number of pixels and 
the amount of data contained in a one square 
inch image, based on the resolution and the 
color mode of the image. 

The actual amount of space on disk occupied 
by an image file depends on the file format 
and whether the image data in the file has 
been compressed.

Amount of image data

Image 
resolution

Pixels 
(square inch)

Black & White
(1 bit)

Grayscale
(8 bit)

RGB Color
(24 bit)

CMYK Color
(32 bit)

100 ppi 10,000 1.2 KB 9.7 KB 29.3 KB 39.0 KB

150 22,500 2.7 22.0 65.9 87.9

200 40,000 4.9 39.0 117.2 156.3

250 62,500 7.6 61.0 183.1 244.1

300 90,000 11.0 87.9 263.7 351.6

350 122,500 15.0 119.6 358.9 478.5

400 160,000 19.5 156.3 468.8 625.0

Relative size of pixels

Resolution measures the size of pixels as how 
many fit in a set distance. Higher resolution 
results in smaller pixels filling the same area; 
smaller pixels produce finer images.

12 picas 6 picas

150 pixels (75 ppi) 150 pixels (150 ppi)
23
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Separating colors for printing

Because each printing plate on a press prints 
one color, to print a document with more 
than one color requires an additional plate 
for each additional color. Printing black text 
and green illustrations, for example, requires 
one plate with black ink to print text, and 
another plate to print the illustrations in 
green.

To make the printing plates for a color 
publication, the objects on each page have to 
be separated by color, so all the objects that 
print with the same color appear on the same 
printing plate. Film or proofs created from 
the color-separation process are called color 
separations.

Process color and spot color printing require 
different types of color separations. By 
selecting appropriate colors in Canvas, you 
can make color separations for either type of 
color printing.

For spot color printing, separations are made 
based on the names of spot colors in the 
document. The names are preset in the spot 
color system you choose. In Canvas, you can 
use Pantone and Toyo color systems for spot 
colors. You can also create your own spot 
colors (and name them) in the Inks palette 
for special purposes.

For process color printing, color separation 
is somewhat more complicated, because all 
the colors in the document will be printed 
from three primary colors and black. When 
separated, objects often appear on more than 
one printing plate because their colors will 
be printed with a combination of process 
color inks.

For example, in process printing, red is 
made by printing magenta and yellow 
together. A red object in your document 
would appear on the yellow and magenta 
separations and plates.



When color separation was performed by 
hand, it was a tedious, exacting art. In 
Canvas, the separation process is automatic 
and almost as simple as printing a document.

When you create color separations with 
Canvas, the program determines which 
objects and images belong on which plates. 
You can print separations to check a 
document’s colors in the proofing process 
and then create the final film separations 
needed to make plates for the printing press.

For special situations, you can use layers in a 
Canvas illustration document to create color 
separations the way artists separate a 
physical layout using overlay sheets. 

For example, you can use a layer as the 
separation for a gloss varnish on the press. 
Copy the objects that get varnish, or draw 
corresponding shapes on a new layer. Create 
a spot color named “Varnish” and apply it to 
the objects’ fill and pen inks. You can print 
just the varnish layer as a separation. Also, 
you can let Canvas output a separation for 
the “Varnish” plate.

Y

Process color combinations

The process colors Cyan, Magenta, and Yellow 
can theoretically make all hues. Black ink is used 
to provide shadow detail and reduce the overall 
amount of ink required.

Y+M

Y+M+C Y+M+C+K
25
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Printing with process colors

It might seem that printing a rainbow would 
require that a printing press be filled with a 
rainbow of color inks. 

Actually, most color printing is based on the 
fact that only three primary colors are 
needed to reproduce a full spectrum of hues 
(with black added for darker shades). This 
printing technique is referred to as four-
color or process printing.

Cyan, magenta, yellow, and black 
(abbreviated CMYK) are the four ink colors 
used for process printing. Cyan, magenta, 
and yellow are special colors known as the 
subtractive primary colors.

These colors are called primary because they 
can be used (theoretically) to make all other 
colors. The term subtractive is used because, 
when white light (which contains all colors) 
reflects off these colors on the page, they 
subtract some of the light’s colors and 
reflect the rest.

When cyan, magenta, and yellow inks are 
printed on top of each other, they subtract all 
color from light striking the printed surface. 
In theory, they appear as black. In fact, black 
ink is also needed to produce true blacks 
because of the limitations of the inks and 
presses.

Four-color printing requires four printing 
plates on the press, one for each of the 

Yellow Magenta Cyan Black

RGB colors (left) displayed on a computer monitor 
blend to make white light. The CMY colors used in 
process printing subtract color from white light and 
reflect the remaining color.

RGB CMY



process colors. Presses that have more than 
four printing units can print a publication 
with spot colors and varnishes in addition to 
process colors.

Most colors are made with less than 100% of 
each process color, so they are separated into 
halftone images on each printing plate. The 
percentage of the primary color is the 
percentage of the halftone screen. 

For example, to print orange with 90% 
yellow and 20% magenta, the yellow 
separation has a 90% halftone screen; the 
magenta separation has a 20% percent 
halftone. A separation has a solid (not 
screened image) only when a color is printed 
at 100% from the corresponding plate.

The halftone screening required for process 
printing makes an image into a grid of tiny 
dots. If this grid of dots was the same for 
each process color, the dots would form 
muddy spots on the page.

Instead, color separations are made with the 
halftone screens at different angles to each 
other. When printed, the screened dots line 
up in tiny circular rosettes. The rosette 
pattern lets our eyes see many colors in the 
dots of CMYK inks.

105°

90°

75°

45°

0°

The halftone screens of process color separations 
are set at specific angles so the halftone dots form 
rosettes. Incorrect angles can create distracting 
patterns.

Four colors in process printing

Yellow, magenta, cyan, and black are printed together to 
reproduce full-color images such as photographs. Each sepa-
ration is a halftone image, with gray levels that correspond to 
the amount of cyan, magenta, yellow, or black in the original 
image.
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Designing documents in color

Problems with color separations and press 
limitations can lead to disappointment with 
the appearance of a printed publication. You 
can help ensure accurate color reproduction 
for your publications by keeping in mind 
potential problems as you design your 
documents. 

The process color gamut

The range of colors that can be printed with 
CMYK inks is much smaller than the range 
of colors that the human eye can perceive. 
Colors printed with process inks seem less 
vibrant and saturated than they appear on the 
monitor of your computer.

Many colors that you see in nature or on 
your monitor can’t be printed with process 
color inks. These colors fall outside the 
“CMYK gamut.” 

On screen, Canvas tries to simulate the 
appearance of all colors as they’ll appear 
when printed. When you select inks for 
process printing, use the CMYK or 
Trumatch color models to avoid using colors 
that can’t be printed accurately as process 
colors.

When you create color inks in Canvas using 
the RGB or HSL (hue, saturation, lightness) 
color systems, the program can tell you if a 
color is outside the CMYK gamut. While no 
color looks the same on a computer monitor 
as it does when printed, a color that Canvas 
identifies as “out of gamut” should be 
checked and possibly changed before you 
create color separations.



Specifying process colors

For specifying process colors in Canvas, you 
can use the Trumatch color system. 
Trumatch is a system of 2,000 colors, 
arranged in 50 hues, with 40 tints and shades 
of each hue.

Trumatch is a patented system of color 
specification. It’s designed to let you select 
from evenly spaced hues, with smooth, 
proportionate tints (lighter and darker 
shades) of the basic hues.

You can specify Trumatch colors from the 
Color manager in the Canvas Inks palette. If 
you use Trumatch colors, be sure to obtain 
and refer to the Trumatch Colorfinder, the 
printed reference guide that shows the actual 
appearance of all Trumatch colors. The 
Colorfinder is available in versions for 
coated and uncoated paper stock from 
Trumatch, Inc. 

Printed guides like the Trumatch 
Colorfinder are the only reliable way to 
select colors based on their actual printed 
appearance.

Hi-fidelity color systems 

High-fidelity color is a name for printing 
methods that use six colors to overcome 
some limitations of four-color printing.

“Hi-fi” color requires special printing inks, 
screening methods, and proofing systems. 
Though it might someday become common, 
hi-fi color is still an emerging technology. 

New color systems can be difficult to adopt 
because they require new methods for 
creating, separating, proofing, and printing.
29

To select process color hues, refer to a color guide printed on 
the type of paper you are using. Use one of the CMYK models 
to enter CMYK percentages in the Canvas Inks palette. With 
the Trumatch Colorfinder, you can see printed colors and 
specify colors by number after selecting the Trumatch color 
model in the Inks palette. 
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Specifying spot colors

Process color inks can’t be used to 
reproduce some hues, such as really bright 
orange shades. Also, using four plates to 
print process color is more expensive than 
using fewer plates when all you need are 
accent colors. In these situations, spot color 
is the solution.

A spot color is a pre-mixed color ink used on 
a printing press. Spot colors are available in 
hundreds of hues and special metallic and 
fluorescent shades.

Spot colors are used for both low-cost and 
high-quality publications. Using one spot 
color can open creative possibilities for 
inexpensive newsletters and advertisements. 
By printing with one spot color on colored 
paper, a designer can create eye-catching 
publications at lower cost than process color 
printing.

In high-end publications, spot colors can be 
used to gild a page with gold, bronze, silver 
and copper. Spot color inks also are called 
for when designers want rich, saturated hues 
that can’t be made with CMYK inks. 

Another reason for using spot colors is to 
avoid problems caused by misregistration of 
process colors. Also, a spot color printed at 
100 percent (solid) doesn’t have a halftone 
screen pattern; printing the same hue with 
process colors can result in a distracting dot 
pattern.

A widely used system for selecting and 
specifying spot colors is the PANTONE 
Matching System. Pantone, Inc. developed 
its set of standard inks and printed reference 
guides so designers and printers could 
guarantee specific solid colors.

In the Inks palette in Canvas, you can 
choose Pantone colors designed for coated 
and uncoated papers, as well as spot colors 
from the Toyo reference system. 

When you specify a spot color, you must 
refer to a printed reference guide to be sure 
of the color’s printed appearance. No color 
monitor, no matter how well calibrated, can 
show the true hue and appearance of a spot 
color ink. Even with the color matching 
systems in Canvas, colors displayed on a 
monitor can only approximate spot color 
hues.



Knockouts and overprinting

PostScript graphics programs (including 
Canvas) usually don’t print any part of an 
object that is covered by another object. A 
foreground object punches a hole, called a 
“knockout,” where it overlaps a background 
object.

This is why Canvas displays objects as solid 
and opaque on screen. For example, if you 
draw a red object on a blue object, you see 
red, not the color that red would become 
with blue printed behind it.

Knocking out objects in color separations is 
necessary to avoid unwanted color mixing 
on the printed page. But it also means that 
plain paper will be seen at the edge of the 
knockout area if the plates don’t print 
exactly “in register.”

If printing plates aren’t properly aligned on 
the press, or the paper shifts even minutely 
during printing, gaps between colors will 
result in thin colors or blank paper showing 
through.

Problems with registration (alignment) are 
most common when printing newsprint on 
high-speed web presses. In this case, the 
tendency of newsprint to stretch will 
aggravate slight registration problems.

Overprinting — printing one ink color on 
top of another color without a knockout — 
is one technique that can be used to avoid 
registration problems. However, because 
process color inks are transparent, 
background colors change the appearance of 
an overprinted process ink. This can be used 
to your advantage if you plan ahead.

Knockout

If the small circle is set to overprint, no 
knockout is made; the process colors combine 
into a new shade where the objects overlap.

Normally, a front object makes a knockout in a 
back object to prevent unwanted color mixing.

Overprint

100 M

100 C

100 M

100 C

100 M
100 C
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Overprinting black

Often, the black plate is set to overprint 
rather than knockout the colors behind it. 
Black is generally strong enough to print 
over other colors without a significant color 
shift. 

In almost all cases, black text should be 
overprinted when it appears on a colored 
background. Otherwise, misregistration can 

let the knockout for each character become 
visible. 

It’s also a good idea to overprint black text if 
you need to change the text later. If the text 
is overprinted, only the black plate needs to 
be changed; the other separations can be 
reused.

Blessing
of
the Fleet

Spray

Overprinting is a good idea to prevent knockouts 
and color gaps from appearing if printing plates are 
not perfectly aligned. The word at right is set to 
overprint, while the one below it is set to knockout 
the background.

August 1, 1996

Spray

Spray



To overprint objects

You can use the Object Info palette in 
Canvas to overprint selected objects.

Select the objects that you want to overprint 
and choose Object Info in the Object menu. 
Click the Options tab in the Object Info 
palette. On the Options tab, turn on the 
Overprint Object option and then click 
Apply.

Remember that overprinting is an effect you 
can see only on the printed page. Canvas 
does not display the effect of overprinting on 
screen, and overprinting is not visible in 
proofs you print with the Composite option 
in the Print dialog box.

To see the effect of overprinting, you can 
print a proof of color separations and check 
how the objects appear on each separation. 
Objects that are set to overprint should not 
create a knockout in objects that they 
overlap.

You can also set the entire black plate to 
overprint by checking the Overprint Black 
option in the Separation Setup dialog box.

Overprinting text 

You can set text to overprint with the 
Overprint command in the Style submenu in 
the Text menu. Use this method to overprint 
an entire text object, or to overprint selected 
text within a text object.

The Overprint 
option appears on 
the Options tab in 
the Object Info 
palette.
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Trapping

Trapping is the process of modifying 
illustrations so slight misregistration in 
printing doesn’t cause knockouts or 
unwanted colors to appear. Trapping creates 
small areas of overlapping color (called 
traps) where objects of different colors meet.

You can tell Canvas to apply choke or 
spread trapping to selected objects. You can 
use spread trapping in text by selecting the 
text and choosing Spread in the Style 
submenu in the Text menu.

To use the trapping feature in Canvas 
effectively, discuss press registration and 
trapping with your commercial printer. Ask 
what the trap size should be for a particular 
printing setup. You can set the trap size 
Canvas uses on the Options tab in the 
Separation Setup dialog box.

Applying traps to selected objects

You assign trapping to objects using the 
Object Info palette. Select the objects you 
want to trap and choose Object Info in the 
Object menu. On the Options tab, turn on the 
Trap Object option. You can apply a choke 
or spread trap by clicking an option button.

• Choke shrinks the knockout in a light 
background object, making a slight 
overlap with the edges of a darker 
foreground object. You can apply 
choke trap to objects that have a visi-
ble stroke. 

• Spread increases the size of a selected 
foreground object so it slightly over-
laps the knockout in a background 
object. You can apply spread to all 
objects except images. Spread is used 
to trap a selected foreground object 
against a darker background.

Spread Choke



PROOFING AND PRINTING SEPARATIONS

Before you create a document that will be 

printed commercially, you can take steps to 

ensure that colors you use in your document 

are represented as accurately as possible on 

screen. Canvas provides tools to help you 

calibrate a monitor to achieve more accurate 

color displays.

You can also use special display modes in 

Canvas to check for color problems, such as 

RGB colors that can’t be reproduced using 

process colors. 

During the proofing stage of the publication 

process, you can select printing options that 

let you use desktop printers to verify that 

objects and colors will appear on the correct 

color separations.

When your document is ready for final out-

put of film for color separations, you can 

print directly to high-resolution imagesetters 

or create PostScript separation files. An 

imagesetting service or your printer can use 

these files to output the separation films 

needed to make printing plates for your pub-

lication.
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Monitor calibration

Calibrating a monitor provides information 
on its color characteristics, which Canvas 
uses when it simulates process and spot col-
ors in the RGB color space of the video dis-
play. Entering the correct settings for your 
monitor can help make the color simulation 
more accurate.

Monitor calibration affects the display of 
color inks specified in CMYK and spot color 
models in Canvas. The Monitor Setup com-
mand lets you enter the values for a moni-
tor’s gamma, white point, and phosphor 
colors. You can also tell Canvas to adjust the 
color display to compensate for low, 
medium, or high ambient lighting. 

You can save the settings in the Monitor 
Setup dialog box for a particular monitor 
configuration. You can load monitor calibra-
tion settings when you use Canvas with a 
different monitor, or when you want to com-
pare several sets of values to actual printed 
output. 

Of course, adjustments that you make to a 
monitor using its brightness, contrast, and 
color controls also affect the way that colors 
appear on screen. Once your monitor is cor-
rectly calibrated, it’s a good idea to tape 
down the monitor’s adjustment knobs or 
buttons to prevent accidental changes.

In controlled viewing environments, correct 
calibration can enhance color accuracy. 
However, calibration can’t compensate for 
all the factors that make color matching 
between a video display and the printed page 
difficult. Calibration can’t compensate for 
changes in ambient light during the day, and 
changes in a monitor’s phosphors as they 
age, both of which affect the appearance of 
colors on screen.
6



To calibrate a monitor

1 Once your monitor has warmed up for sev-
eral minutes, choose Calibration > Monitor Setup 
in the Edit menu. The Monitor Setup dialog box 
opens.

2 If your monitor type is listed in the Monitor 
pop-up menu, select it to use the standard set-
tings. Otherwise, choose Default.

3 In the Ambient Light pop-up menu, select 
Low, Medium, or High, depending on whether the 
light in the room is dim, medium, or bright.

4 If you know your monitor’s parameters and 
want to enter custom values, do the following:

• Enter a custom gamma value in the Gamma 
text box. The gamma value must be 
between 0.75 and 3.0, or Canvas alerts you 
and substitutes the closest acceptable 
value. In general, higher gamma values 
lighten the color palette.

• Select a value in the White Point pop-up 
menu. Or, choose Custom, enter X and Y 
values in the White Point dialog box, and 
click OK to return to the Monitor Setup dia-
log box.

• Select a phosphor type in the Phosphors 
pop-up menu, or select Custom, enter val-
ues in the appropriate text boxes in the 
Phosphors dialog box, and click OK to 
return to the Monitor Setup dialog box. 
Phosphor values must be between 0.0001 
and 1.0.

5 To save the current settings as a custom 
setup file, click Save. In the directory dialog box, 
select a location and type a file name for the setup 
file. Click Save to save the file.

6 To load a monitor setup file, click Load. In the 
directory dialog box, select the monitor setup file 
you want to use and click Open.
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Display modes for previewing colors

When preparing publications for printing, 
you want to be sure that the colors used in 
the document files will separate correctly, 
and that the final printed result will match 
your expectations.

Colors specified in RGB, HSL, and Pantone 
color systems can be outside the CMYK 
gamut, the range of colors that can be repro-
duced exactly with CMYK inks. When Can-
vas separates a document for process color 
printing, it converts colors that are out of the 
CMYK gamut to the closest CMYK color. 
The result can be printed colors that differ 
significantly in hue and lightness from the 
originals.

Canvas provides display modes to help you 
avoid color problems. Canvas can highlight 
colors that might cause problems during sep-
aration or printing. Canvas can also display a 
simulation of the effect of converting all col-
ors in a document to process colors. 

Gamut warning display

You can tell Canvas to highlight on screen 
any colors in a document that are outside the 
CMYK gamut. These colors are likely to 
differ the most between on-screen and 
printed appearance.

To show out-of-gamut colors

When you turn on the Gamut Warning dis-
play, Canvas displays a special highlight 
color on all objects that are outside the 
CMYK gamut. By default, the gamut warn-
ing color is bright green.

1 Choose the Display > Gamut Warning com-
mand in the Layout menu. A check mark appears 
next to the command in the menu when this dis-
play mode is active. To return to normal display 
mode, choose Gamut Warning again.

2 To change the gamut warning color, choose 
Calibration > Gamut Warning in the Edit menu.

• Select a color from the pop-up menu. 

• Enter an opacity percentage value in the 
Opacity box. 

3 Click OK to implement the new setting.

Q1 Q2 Q3 Q4
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RGB colors appear more vibrant than 
process colors
8



CMYK Preview mode

CMYK Preview is a display mode that sim-
ulates the appearance of colors in the 
CMYK color space used in process color 
printing.

For example, in CMYK Preview mode, 
bright green (Green value 255 in RGB) 
appears darker and duller. Of course, this 
color change is a simulation of actual 
CMYK colors, because computer monitors 
can display only RGB colors.

It’s a good idea to look over a document’s 
colors in CMYK Preview mode if you 
import illustrations that use RGB colors into 
a document that will be printed with process 
colors. The CMYK Preview mode should 
also be used to check spot colors if these col-
ors will converted to process colors for 
printing.

The CMYK Preview mode is 
the same as the preview in the 
Inks palette’s Color manager. 
The box by the warning sym-
bol is a CMYK preview of the 
current color.

To preview CMYK colors

Use the CMYK Preview command to see a 
document in simulated CMYK color space.

1 If the Gamut Warning command (in the Dis-
play submenu in the Layout menu) is active, turn 
this display mode off by choosing the Gamut 
Warning command. 

2 Choose Display > CMYK Preview in the Lay-
out menu. A check mark appears next to the com-
mand in the menu when CMYK Preview is active.

Q1 Q2 Q3 Q4
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Gamut Warning display mode highlights 
colors that are outside the CMYK gamut

CMYK Preview display mode simulates the 
appearance of printed process colors
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Selecting and setting up a printer

Canvas lets you print your publications on 
desktop printers (using any printer driver 
compatible with your system) and output 
documents on high-resolution PostScript 
imagesetters.

Desktop printers can serve a number of pur-
poses during the preparation of your publi-
cation. You can print to black-and-white 
desktop printers to check text and images. 
You can use color printers for general color 
proofing and to check that colors are 
assigned correctly. You can also use black-
and-white or color printers to proof the color 
separations produced by Canvas.

To create color separations of a document 
for commercial printing, you can print 
directly to an on-site imagesetter, or create 
files that can be handed off to an imageset-
ting service or commercial print shop.

When you set up a printer to use with Can-
vas, you can select paper sizes and other out-
put options. You can configure desktop 
printers for proofing your publication, and 
then change output options before you send 
final color separations to an imagesetter. 

Using PPD files

Canvas uses a PostScript Printer Description 
(PPD) file when it prints to a PostScript 
printer. When you select a printer, you can 
also select a PPD file for the printer. If you 

send PostScript files to a commercial printer, 
find out which PPD file you should use.

A PPD file is simply a text file containing 
information and PostScript commands. Can-
vas reads the PPD file to obtain information 
about the printer’s capabilities. 

Using the correct PPD file is important — 
especially for output of final color separa-
tions — because the PPD file tells Canvas 
the resolution, halftone screen settings, built-
in fonts, color capability, and available 
memory in the output device.

In Mac OS, a PPD’s file name contains the 
printer name and a version number. In Win-
dows, the PPD file name is a short (8-char-
acter) name; the file itself contains the full 
printer name. For example, the PPD file 
named “LaserWriter IIg v2010.113” on Mac 
OS is named “APLWIIg1.PPD” on Win-
dows systems. This information can be read 
in the first section of the PPD file itself.

You can select any PPD file to use with any 
printer, but if you don’t use the correct PPD, 
the information Canvas reads won’t be accu-
rate. Some printers have more than one PPD 
for the same model with different amounts 
of memory installed.
0



To select a PPD file

Mac OS PPD files are in the Printer 
Descriptions folder inside the Extensions 
folder. After you select a printer in the 
Chooser, select a corresponding PPD file by 
clicking the Setup button. 

Windows After you use the Printer Setup 
command to select a printer, click the PPD 
pop-up menu in the Printer Setup dialog box 
to select a corresponding PPD file. If no 
PPD file names appear in the pop-up menu, 
choose Other. In the directory dialog box, 
navigate to the folder where PPD files are 
stored on your system, select the file you 
want to use, and click Open.

If a text file named “Filename.map” is in the 
folder where you select a PPD file, Canvas 
reads the list of PPD file names from the text 
file. Canvas displays these PPD names in the 
PPD pop-up menu in the Printer Setup dia-
log box.

If the “Filename.map” file doesn’t exist, you 
can use any program that saves plain text 
files to create it. In the file, type one PPD file 
name on each line. Following each file 
name, type a space and the name of the 
printer associated with the PPD file.

What’s in a PPD file?

PPD files use a common structure and pro-
vide information about specific printers. 
Users who understand PostScript can 
modify PPD files to add custom settings. 
To view the contents of a PPD file, you can 
open it in a word processor that supports 
plain text (such as TeachText or WordPad).

*% Color Separation Information 

=====================

*% Use Linotype Utility 3.0 to invoke HQS

*DefaultColorSep: ProcessBlack.120lpi.2438dpi/120 lpi / 2438 

dpi

*InkName: ProcessBlack/Process Black

*InkName: CustomColor/Custom Color

*InkName: ProcessCyan/Process Cyan

*InkName: ProcessMagenta/Process Magenta

*InkName: ProcessYellow/Process Yellow

*%  For 133 lpi / 3251 dpi

*ColorSepScreenAngle ProcessBlack.133lpi.3251dpi/133 lpi / 

3251 dpi: "45.0"

*ColorSepScreenAngle CustomColor.133lpi.3251dpi/133 lpi / 

3251 dpi: "45.0"

*ColorSepScreenAngle ProcessCyan.133lpi.3251dpi/133 lpi / 

3251 dpi: "15.0"

*ColorSepScreenAngle ProcessMagenta.133lpi.3251dpi/133 

lpi / 3251 dpi: "75.0"

*ColorSepScreenAngle ProcessYellow.133lpi.3251dpi/133 lpi 

/ 3251 dpi: "0.0"

*ColorSepScreenFreq ProcessBlack.133lpi.3251dpi/133 lpi / 

3251 dpi: "133.0"

*ColorSepScreenFreq CustomColor.133lpi.3251dpi/133 lpi / 

3251 dpi: "133.0"

*ColorSepScreenFreq ProcessCyan.133lpi.3251dpi/133 lpi / 

3251 dpi: "133.0"

*ColorSepScreenFreq ProcessMagenta.133lpi.3251dpi/133 lpi 

/ 3251 dpi: "133.0"

*ColorSepScreenFreq ProcessYellow.133lpi.3251dpi/133 lpi / 

3251 dpi: "133.0"

*%  For 150 lpi / 3251 dpi

*ColorSepScreenAngle ProcessBlack.150lpi.3251dpi/150 lpi / 

3251 dpi: "45.0"

*ColorSepScreenAngle CustomColor.150lpi.3251dpi/150 lpi / 

3251 dpi: "45.0"

*ColorSepScreenAngle ProcessCyan.150lpi.3251dpi/150 lpi / 

3251 dpi: "15.0"

*ColorSepScreenAngle ProcessMagenta.150lpi.3251dpi/150 

lpi / 3251 dpi: "75.0"

*ColorSepScreenAngle ProcessYellow.150lpi.3251dpi/150 lpi 

/ 3251 dpi: "0.0"
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Page Setup for Mac OS

In Mac OS, you can use the Page Setup 
command to change page size, orientation, 
positive or negative imaging, and scaling for 
output.

Some options in the Page Setup dialog box 
depend on the printer you select in the 
Chooser. The Page Setup dialog box with 
the Apple LaserWriter 8.3 driver selected is 
shown below.

Several Canvas options in the lower part of 
the Page Setup dialog box affect the way 
Canvas formats large and small documents 
to fit on standard paper. See “Centering and 
tiling illustrations” on page 54 for more 
information.

Paper

This pop-up menu contains the paper sizes 
specified by the printer driver or the 
PPD file for the printer. Choose the paper 

size used in your desktop printer or the size 
of the media used in the imagesetter. 

The “dogcow” illustration gives a visual rep-
resentation of the Page Setup settings. The 
illustration shows the Paper, Layout, and 
Orientation settings, but not a scaling factor 
in the “Reduce or Enlarge” box.

When you change the page orientation in the 
Page Setup dialog box, the change isn’t 
reflected on-screen or in the Document 

The illustration reflects 
the current settings.

Click the bottom-right corner of the illustration (left) 
to show paper and margin dimensions (right).
2



Setup dialog box. However, the document 
prints with the selected page orientation. 
Conversely, changing the page orientation in 
the Document Setup dialog box changes the 
on-screen page layout, but won’t affect the 
way a document prints.

To change the page orientation both on-
screen and for the printed product, you need 
to set the orientation using both the 
Document Setup command in the Layout 
menu and the Page Setup command in the 
File menu.

Custom paper size

If you use LaserWriter printer driver 8 or 
later, you can choose Custom in the Paper 
pop-up menu if the selected PPD supports 
“custom” paper size. Click the bottom-right 
corner of the illustration to show paper and 
margin dimensions. Select the numeric val-
ues and enter the custom dimensions.

Choose Imagesetter button

The Choose Imagesetter button appears only 
when you select a LaserWriter 7 printer 
driver in the Chooser, because this driver 
doesn’t let you select Custom in the Paper 
pop-up menu. 

1 To specify a custom page size, click the 
Choose Imagesetter button. 

2 In the PostScript Setup dialog box, use the 
options to specify dimensions, scaling, and orien-
tation for custom-size pages.

3 Choose a PPD file for the output device from 
the PPD pop-up menu. The name of the associ-
ated printer appears above the menu.

4 The Paper area shows the dimensions for the 
selected page size. To enter your own dimen-
sions, choose Custom Page in the pop-up menu. 
In the Custom Page area, enter the page dimen-
sions in the Width and Height boxes. Choose Por-
trait or Landscape in the Orientation pop-up 
menu. Click OK to implement the settings.

Use this dialog box to set custom paper sizes 
when you use a driver that doesn’t offer a Custom 
Paper option.
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Printer Setup for Windows

You can use the Printer Setup command in 
Canvas to select a printer and PPD file. In 
the Printer Setup dialog box you can set 
options for scaling, centering, and tiling a 
publication and for printing information on 
color separations. 

In the Printer Setup dialog box, click the 
Setup button to open the properties dialog 
box for the selected printer. In this dialog 
box, you can change paper size, orientation, 
positive or negative imaging, and scaling for 
output.

The Apple LaserWriter Properties dialog 
box shown here is similar to ones for most 
PostScript printers, with page setup and 
printing options organized on tabs.

Paper tab

Use the Paper tab to select paper size, lay-
out, orientation, and number of copies. 
Related options, which let you tile and cen-
ter output, are available in the Print dialog 
box.

When you select a paper size, be sure it pro-
vides enough extra space outside the docu-
ment for bleeds and printer information. If 
the printer driver lets you select a custom 
paper size, a Custom icon appears under 
Paper Size and you can enter your own 
paper dimensions.
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Graphics tab

The Graphics tab contains options for output 
resolution, halftones, and imaging. For out-
put of final film separations, however, these 
options should be set in Canvas using the 
Separation Setup dialog box, not here. 

• A resolution setting in effect at the 
imagesetter or RIP takes precedence 
over the Resolution setting on the 
Graphics tab.

• Halftone settings in Canvas always 
supersede the Screen frequency and 
Screen angle settings on the Graphics 
tab. For color separations, Canvas uses 
the settings on the Screens tab in the 
Separation Setup dialog box. For regu-
lar printing, Canvas uses the settings on 
the Printing tab in the Preferences dia-
log box.

• You can select negative and mirror 
image (wrong-reading) output options 
on the Graphics tab. However, some 
output devices also let you set these 
options. You might need to test the out-
put before producing final film separa-
tions to be sure the correct settings are 
in effect.

Device Options 

This tab contains options for the output 
device, such as text and photo-enhancement, 
that can be controlled through software. The 
available options depend on the device. 
Consult the device documentation for infor-
mation.

PostScript

This tab has options for PostScript format-
ting from the printer driver. However, Can-
vas creates PostScript data itself, rather than 
relying on the printer driver, so these options 
affect only the preamble or header informa-
tion sent to the output device or file along 
with the PostScript page descriptions gener-
ated by Canvas.
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Outputting color separations

To output color separations, you can print to 
a desktop printer or imagesetter, or create 
PostScript separation files by printing to 
disk.

When creating color separations in Canvas, 
first select the output device and the match-
ing PPD file before configuring other set-
tings. Canvas reads information in the PPD 
file for paper size and halftone screen 
angles. If you don’t select the correct printer 
and PPD file, the available paper options 
and screen angles might not match those 
available on the output device.

In Mac OS, you use the Chooser to select 
printers and PPD files. In Windows, you use 
the Printer Setup command in Canvas or the 
Printers control panel. For more information 
about connecting to printers, refer to the 
documentation for the operating system you 
use.

Some of the options available with the Page 
Setup (Mac) and Printer Setup (Windows) 
commands also affect color separations. For 
example, use these commands to select doc-
ument orientation (portrait or landscape) and 
image format (positive or negative, normal 
reading or reversed).

You usually choose paper size and orienta-
tion and set other options when you first cre-
ate a document. However, you might change 

some settings depending on whether you’re 
creating color separations for proofs or final 
film output.

After selecting the printer and PPD file, you 
can prepare to output color separations in 
Canvas. 

• To set options for color separations, use 
the Printing Inks, Color Separations, 
and Separation Tables commands in the 
Calibration submenu in the Edit menu. 
For more information, see “Calibrating 
printing inks and color separations” on 
page 51.

• In the Print dialog box, you can choose 
the data format for images and the color 
format for the separations. 

• Click the Setup button in the Print dia-
log box to open the Separation Setup 
dialog box. Use this dialog box to set 
the halftone screen frequency, choose 
which plates to print, and set other 
options for separations. For more infor-
mation, see “Separation Setup dialog 
box options” on page 49.
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Steps to follow for creating color 
separations

1 Open the document in Canvas. In illustration 
and presentation documents, be sure that all lay-
ers you want to include are visible. Because Can-
vas can separate any object into CMYK process 
colors, you don’t need to convert objects before 
creating separations.

2 Make sure the correct printer and PPD file are 
selected on your system. If necessary, use the 
Page Setup command (Mac) or Printer Setup com-
mand (Windows) to verify the paper orientation 
and layout settings. See “Page Setup for Mac OS” 
on page 42 or “Printer Setup for Windows” on 
page 44 for more information.

3 Choose Print in the File menu. Set up the 
options in the Print dialog box as follows:

• Select the All option button.

• Set copies to the number desired.

• In the Print pop-up menu, choose Docu-
ment. If you want to proof individual illustra-
tions, first select the object in the 
document, and then select Selection in the 
Print pop-up menu.

• In the Print As pop-up menu, choose Sepa-
rations. This option is available only if the 
document contains objects that can be sep-
arated.

• Turn on the Print Info option to include 
printer’s marks (which you can select sepa-
rately in the Separation Setup dialog box) 
on separations.

• In the Images pop-up menu, choose the 
data format for images (paint objects). For 
compatibility with most networks, including 
Internet Protocol networks, select ASCII. 
You can use Binary for Mac OS and other 
networks that can transmit binary data. 
Binary transmission is twice as fast as ASCII 
format for image data.

• Click the Setup button to open the Separa-
tion Setup dialog box. See “Separation 
Setup dialog box options” on page 49 for 
information on how to configure these 
options.

4 After you configure the options in the Separa-
tion Setup dialog box, click OK.

5 Click Print to print the color separations.

Printing proofs of color separations

It’s always a good idea to include a proof 
copy of the publication when you give sepa-
rations files to an imagesetting service or 
commercial printer. The proof copy can be a 
full-color or black-and-white version of the 
publication.

If you have access to a color printer, you can 
check that colors are printing correctly and 
you can view the printing plates in color. 

Keep in mind that the only accurate color 
proofs are those made from the actual sepa-
ration films that will be used to create the 
printing plates, or color proofs run on the 
printing press.

For printing separation proofs, you might 
want to use the Skip Blank Pages option in 
the Print dialog box. Turn on this option to 
tell Canvas not to print any pages in the doc-
ument that are completely blank. 

For proofing large documents, you can tell 
Canvas to divide the pages into tiles. See 
“Centering and tiling illustrations” on 
page 54.
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Previewing a document before printing

In the Print dialog box, you can click the 
Preview button to see an on-screen preview 
of the pages Canvas will print. When you 
are printing separations, you can see the 
individual separations in the preview win-
dow.

The preview reflects all the settings in the 
Print dialog box and Separation Setup dialog 
box. For example, the preview shows the 
plates you select to print and shows the 
plates in color or grayscale depending on 
whether you turn on the “Print Plates in 
Color” option on the Options tab in the Sep-
aration Setup dialog box.

Creating disk files of color separations

Rather than printing directly to an output 
device, you can create digital separation files 
in Canvas. Separation files are PostScript 
files that can be downloaded to an imageset-
ter for output. Separation files let you trans-
fer a finished, separated document for 
remote printing without Canvas.

1 Follow the instructions for page setup and 
selecting options in the Print dialog box and Sep-
aration Setup dialog box. 

2 Click the File option in the Print dialog box, 
and then click Save (Mac OS) or OK (Windows).

3 In the directory dialog box, select a location 
and type a name for the file that will be created. In 
Mac OS, choose All in the Font Inclusion pop-up 
menu if your document contains type. In Win-
dows, fonts are automatically included in the Post-
Script file.

4 After entering the settings you want, click 
Save (Mac OS) or OK (Windows) to create the sep-
arations PostScript file.
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Separation Setup dialog box options

Use the Separation Setup dialog box to 
select the separation plates to print, and to 
configure options for screening halftones, 
trapping, overprinting black, printing spot 
colors as process, and printing plates in color 
for proofing. Ask your commercial printer 
about the settings for your publication.

General tab

At the top of the General tab, select the 
plates you want to print by Shift-clicking the 
plate names. Selected plates are highlighted. 
For process-color publications, select all 
four plates whose names begin with “Pro-
cess.”

The process color plates (cyan, magenta, 
yellow, and black) always appear in this list. 
If the document contains named spot colors, 
their names also appear in the list. Canvas 

prints a color separation for each spot color 
you select.

In the Plate Options area, you can check 
these options to add printer’s marks and 
other information to the separations.

Options tab

On the Options tab, you can tell Canvas how 
to treat certain colors and set a universal 
width for traps that Canvas creates.

If your document contains spot colors that 
you want Canvas to convert to process col-
ors, check the “Convert Spot Colors to 
CMYK” option. However, keep in mind that 
many spot colors can’t be reproduced with 
process colors. Using this option tells Can-
vas to separate the colors as if they were pro-
cess colors, but does not change the colors 
permanently in the document.
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If you want to print the color separations in 
color, rather than grays, check the “Print 
plates in color” option. This lets you simu-
late the actual appearance of the color sepa-
rations. Some publishers use this option and 
print on clear acetate to create a simulated 
color key.

If you want Canvas to overprint the entire 
black separation, check the Overprint Black 
option. When this option is on, no object 
containing 95 percent or more black will 
knock out objects on the other separation 
plates. This is usually recommended to 
avoid registration problems with black text 
and hairline rules.

Screens tab

On the Screens tab, you can set halftone 
screen frequency and angles for separations.

Choose a halftone setting from the Halftone 
pop-up menu. Canvas reads the settings 

from the printer driver and PPD file. When 
you choose a setting, Canvas sets the screen 
frequencies and angles for all plates.

You can use the Color pop-up menu to 
change settings for specific plates. Select the 
plate you want to change, and enter values in 
the Angle and Frequency boxes.

After you set the options in the Separation 
Setup dialog box, click OK to close the dia-
log box and return to the Print dialog box.

Selecting halftone screen frequency

You might want to use a different halftone 
frequency for proofing than for final output. 
Most desktop printers achieve resolutions of 
600 to 1,200 dpi, which isn’t enough to 
reproduce a full range of tones at halftone 
screen frequencies much higher than 65 lpi 
(lines per inch).

Even though your publications will probably 
use halftone frequencies of 85 to 150 lpi, a 
desktop printer can produce cleaner half-
tones if you choose a screen frequency 
within its range. If you use the publication’s 
actual screen frequency, the halftones will 
lose tonal range and clarity.
0



Calibrating printing inks and color separations

Before you print separations, you should use 
the Printing Inks and Color Separations 
commands in the Calibrate submenu (in the 
Edit menu) to check the settings that Canvas 
uses for generating process color separa-
tions. 

Printing Inks calibration

Printing Inks calibration tells Canvas how to 
compensate for the type of paper and print-
ing press used to print a document. If you are 
working on multiple projects, you can create 
printing inks setup files for each one.

Ink color These options correspond to 
standard types of presses, inks, and paper 
stock. Standard Web Offset Press (SWOP) 
inks are used in the United States for offset 
lithography on web presses (which use roll 
paper). Inks used in commercial printing in 
Europe and Asia differ somewhat from those 
used by U.S. printers.

If your print shop advises you to adjust the 
ink colors, you can choose Custom in the 

Ink Color pop-up menu. In the dialog box, 
enter the CIE-LAB color values that your 
print shop specifies. These values are based 
on readings from a spectrophotometer or 
colorimeter. 

Dot Gain This value tells Canvas the 
expected amount (in percent) that halftone 
dots will spread (gain) on the paper surface. 
Different surfaces cause different amounts 
of dot gain. Newsprint requires compensa-
tion for greater dot gain than does printing 
on coated stock. A setting of 20% is typical 
for offset printing on coated stock.

To calibrate printing inks

1 Choose Calibration > Printing Inks in the 
Edit menu.

2 In the Printing Inks dialog box, choose a set-
ting from the Ink Colors pop-up menu.

3 Use the standard value in the Dot Gain box or 
enter the value suggested by your printer.
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4 To save the setup, click Save. In the dialog 
box, type a file name and click Save. To load a set-
tings file, click Load. Select the file in the directory 
dialog box and click Open. The name of the cus-
tom setting appears in the Ink Color pop-up 
menu.

5 To enter custom settings, choose Custom in 
the Printing Inks pop-up menu and enter ink color 
values in the boxes. Click OK to save the custom 
settings.

6 After entering the settings you want, click OK.

Color Separations calibration

Calibration for color separations gives Can-
vas information on the total ink limits of the 
press and the total ink density of the black 
plate. Ask your commercial printer for the 
settings you should use. Otherwise, use the 
Canvas defaults.

Black Generation These options affect the 
amount of black ink generated on the black 
plate of a color separation. By default, Can-
vas chooses Medium. Heavy increases the 
amount of black ink and Light decreases the 
amount. None tells Canvas to generate sepa-
rations without a black plate. Maximum 
maps gray values to only the black separa-

tion. Custom lets you adjust the black gener-
ation curve manually.

Black Ink Limit and Total Ink Limit The 
Black Ink Limit sets the maximum density 
(by percentage) of black ink used in color 
separations. By default, the black ink limit is 
100. The Total Ink Limit is the sum of the 
total percentage of CMYK inks used in color 
separations. By default, this value is 300 
percent. The maximum value you can enter 
is 400 percent.

To calibrate color separations

1 Choose Calibration > Color Separations in 
the Edit menu.

2 Choose an option in the Black Generation 
pop-up menu. If you choose Custom, drag the 
curve in the Black Generation dialog box to adjust 
it, and then click OK. 

3 Enter a percentage value in the Black Ink 
Limit and Total Ink Limit text boxes.

4 To save color separation settings, click Save. 
In the dialog box, type a file name and click Save. 
To load a settings file, click Load. Select the file in 
the directory dialog box and click Open. 

5 After entering the settings you want, click OK.
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Using separation tables

You can save the settings in the Printing 
Inks and Color Separations dialog boxes 
separately, or you can save one “separation 
table” with the settings from both dialog 
boxes. 

If you load a saved separation table, Canvas 
will use the separation table settings regard-
less of changes made with the Printing Inks 
and Color Separations commands.

To save a color separation table

1 Choose Calibration > Printing Inks in the 
Edit menu. Enter the settings for ink colors, dot 
gain, and gray balance as described above and 
click OK.

2 Choose Calibration > Color Separations in 
the Edit menu. Enter the settings for black genera-
tion and ink limit as described above and click OK.

3 Choose Calibration > Separation Tables in 
the Edit menu and click Save.

4 In the Save As dialog box, type a name for 
the separation table, choose a location to save the 
file, and click Save.

To load a separation table

1 Choose Calibration > Separation Tables in 
the Edit menu.

2 In the Separation Tables dialog box, click 
Load. In the directory dialog box, locate and 
select a separation table file.

3 Click Open to load the separation table and 
return to the Separation Tables dialog box. In this 
dialog box, the Use Table options are now 
selected with the name of the separation table file 
that you loaded.

4 Click OK to close the dialog box and to tell 
Canvas to use the settings from the separation 
table.

To override settings in a separation table

1 Choose Calibration > Separation Tables in 
the Edit menu. If a separation table has been 
loaded, its name appears with the Use Table 
options.

2 To use the settings in the Printing Inks dialog 
box instead of those saved in the table, click Use 
Printing Inks in the From CMYK area.

3 If you want to use the settings in the Color 
Separations dialog box instead of those saved in 
the table, click Use Color Separations in the To 
CMYK area.

4 Click OK to close the dialog box and use the 
new settings.
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Centering and tiling illustrations

Centering and tiling options in the Print dia-
log box (Mac and Windows) determine how 
Canvas positions a document when printing. 
When printing proofs, you might need to tile 
the document because of your printer’s 
paper size. 

Center on Paper When this option is on, 
Canvas arranges the document so it prints in 
the center of the page. The result depends on 
the size of the document in relation to the 
paper size.

• If the area of interest of a large docu-
ment is near the center, you can use this 
option to print only the center tile when 
Canvas tiles the document to fit on 
smaller paper. 

• If the document is smaller than the 
paper size, Canvas positions it at the 
upper left of the paper when the Center 
on Paper option is off. When this option 
is on, Canvas prints the document in the 
center of the sheet.

• If the document contains only one illus-
tration and you want to center it on the 
output page, select the object first. In 
the Print dialog box, choose the Print 
Selection option and check the Center 
on Paper option.

Tile Turn on this option when you want to 
divide a large document into multiple tiles 
that fit the selected paper size. This option 

lets you proof a document that’s larger than 
the paper in a desktop printer. Make sure this 
option is off when you output final color 
separations to film.

You can specify how much each tile over-
laps adjacent tiles by entering a value in the 
Overlap box. 

When Center on Paper is off, Canvas starts 
tiling at the top left. When Center on Paper 
is on, Canvas creates one full tile in the cen-
ter and fits the remaining tiles around it.

Document

Center on Paper = off Center on Paper = on

Printer pages

Center on Paper = on
Tiling = on

Illustration printed on large paper

Tiling a document for proofing

Tiling = on
Center on Paper = off
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RESOURCES

In the constantly changing field of digital prepress 

and color printing, in addition to mastering the 

basics, you need to stay on top of new 

developments. This list of resources can help you 

find information to increase your publishing 

knowledge and improve your graphic arts skills.

Books and magazines

The following publications provide information 
on graphics applications, digital prepress, and 
commercial printing. The periodicals listed 
include paid-subscription, controlled-circulation, 
and membership journals.

A GUIDE TO COLOR SEPARATION 
Published by Agfa Prepress Education Resources
P.O. Box 7917 
Mt. Prospect, IL 60056
800-395-7007

As part of Agfa’s prepress series, this technical 
booklet leads you through the course of 
preparing documents for process color printing.

THE DESKTOP COLOR BOOK
Michael Gosney and Linnea Dayton 
Published by MIS Press
115 West 18 Street
New York, NY 10011
619-944-9977

This book is an introduction to color models, 
color-matching software, and output options.

FLASH MAGAZINE
Riddle Pond Road
West Topsham, VT 05086
415-661-7406
Fax: 802-439-6463

Flash Magazine is geared toward laser printer 
users and desktop publishers. Articles include 
glass etching with your laser printer; designing 
with color; and print-on-demand publishing.

IMAGING MAGAZINE
1265 Industrial Highway
Southampton, PA 18966-9839
800-677-3435
Fax: 215-396-8992

This monthly magazine contains news, reviews, 
ads, and articles for business-oriented imaging 
needs.
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NATIONAL ASSOCIATION OF DESKTOP 
PUBLISHERS JOURNAL
462 Boston Street
Topsfield, MA 01983-9915
508-887-7900

NADTP membership
2121 Precinct Line Road, Suite 215
Hurst, TX 76054
800-492-1014
Fax: 817-428-4240

The association publishes the NADTP Journal, a 
monthly magazine of trade news, tips, and 
technology available to members and the public. 
Articles include how to find royalty-free stock 
photography, the best scanner for your needs, 
and working with your commercial printer. 

PHOTO>ELECTRONIC IMAGING
57 Forsyth St. N.W., Suite 1600
Atlanta, GA 30303
http://www.peimag.com

This monthly periodical aimed at digital-imaging 
professionals explores electronic imaging, 
photography, and computer graphics. It includes 
industry news and tutorial guides.

POCKET PAL, A GRAPHIC ARTS 
HANDBOOK, 15TH EDITION
Published by International Paper Company
77 West 45 Street
New York, NY 10036
Copyright 1992

This concise reference book includes a history of 
printing, a glossary of printing terms, and an 
illustrated tour of the printing process from 
paper to book binding.

PRINT ON DEMAND
One Snow Road
Marshfield, MA 02050
617-834-0001
Fax: 617-834-0002

This monthly magazine contains articles on 
digital publishing, including hardware and soft-
ware reviews and prepress organizational tips, 
with special emphasis on short-run digital 
printing technology.

STEP-BY-STEP PUBLISHING
6000 North Forest Park Drive
Peoria, IL 61614
800-255-8800

Step-by-Step publishes two magazines of 
interest to graphic designers and publishers. 
Step-by-Step Electronic Design is a newsletter 
covering publishing software. Step-by-Step 
Graphics is a bi-monthly magazine of design and 
production techniques.

Publishing technologies

The following companies develop and manufac-
ture publishing hardware and software, including 
scanners, operating systems, color matching 
systems, and printers.

APPLE COMPUTER
Main number: 408-996-1010
Apple Fax Info Line: 800-776-2333
http://www.info.apple.com 

Apple develops and markets Macintosh and 
Power Macintosh computer systems and the 
Mac OS operating system. Its worldwide web 
site includes links to technical publications, soft-
ware updates, and product information.
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EASTMAN KODAK COMPANY
901 Elmgrove Road
Rochester, NY 14653-5200

Eastman Kodak Color Management Systems
900 Chelmsford St., Tower Three
Lowell, MA 01851
General information: 800-255-3434
http://www.kodak.com

Kodak manufactures printers, scanners, digital 
cameras, and graphics reproduction materials. 
The Kodak PhotoCD Acquire module 3.0 and 
Kodak Color Management software are inte-
grated in Canvas 5 for Mac OS and Windows.

MICROSOFT CORP.
One Microsoft Way
Redmond, WA 98052-6399
General information: 206-882-8080
Desktop Applications FastTips: 800-936-4100
Operating Systems FastTips: 800-936-4200
http://www.microsoft.com 

Microsoft develops and markets Windows oper-
ating systems and software for both Windows 
and Mac OS. FastTips is an automated, toll-free 
service providing technical information and tips 
on key Microsoft applications.

PANTONE, INC. (AMERICA)
590 Commerce Boulevard
Carlstadt, NJ 07072-3098
201-935-5500

Pantone develops color-matching systems for 
printing inks and products. The company 
publishes color guidebooks for their approved 
printing inks and color materials. Canvas 5 
includes Pantone-licensed computer video simu-
lations for selecting Pantone colors.

PRINTER DESCRIPTION FILES BBS
Adobe Systems, Inc.
Bulletin Board System: 206-623-6984

This electronic bulletin board lets you download 
up-to-date PostScript printer description files.

TRUMATCH
25 West 43 Street, Suite 817
New York, NY 10036-7406
212-302-9100
Fax: 212-302-0890
http://www.trumatch.com

Trumatch develops and markets visual reference 
tools for 4-color selection and matching. The 
company publishes the TRUMATCH Colorfinder 
swatchbook for selecting process inks, and 
TRUMATCH Reference Guide software. Trumatch 
color selection software is built in to Canvas 5.

Image collections 

The following collections of stock images are 
available in a variety of subjects and formats.

DIGITAL STOCK CORP.
400 South Sierra Avenue, Suite 100
Solana Beach, CA 92075
USA: 800-545-4514 
International: 619-794-4040 
Fax: 619-794-4041

KPT POWER PHOTOS
MetaTools
6303 Carpinteria Avenue
Carpinteria, CA 93013
805-566-6200 
Fax: 805-566-6385
http://www.metatools.com

PHOTODISC 
2013 Fourth Avenue, Suite 402
Seattle, WA 98121
USA: 800-528-3472 
International: 206-441-4961 
Fax: 206-441-4961
http://www.photodisc.com

PUBLISHERS DEPOT
800-764-7427
http://www.publishersdepot.com
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On-line information sites

The following files and pages on the worldwide 
web provide useful links for desktop publishers.

DTP INTERNET JUMPLIST
http://www.cs.purdue.edu/homes/gwp/dtp/
clipart.html

A list of links to sites with downloadable images.

FUTURE IMAGE INC.
http://www.imagesite.com/futureimage

A site with information on digital photo-imaging.

GURUS
http://techweb.cmp.com/gurus

A forum for discussions and tips on digital tech-
nology.

THE PRINTED IMAGE
ftp://users.aol.com/printdimag/outgoing/

An electronic publication (in .PDF format) with 
information to aid communication between print 
designers and commercial printers.

THE WORLDWIDE WEB VIRTUAL LIBRARY: 
ELECTRONIC JOURNALS
http://www.edoc.com/ejournal/

A directory of publications available on the Web, 
including digital printing resources and guides.

ZD NET
http://www.zdnet.com

As one of the largest publishers of computer 
industry periodicals and books, including PC 
Magazine, MacUser, and Windows Sources, the 
ZD NET site offers links to many of the 
company’s publications and archives of industry 
news, articles, and software.

Paper companies

The following companies are good sources for 
free publishing information and printed samples.

HAMMERMILL PAPERS
6400 Poplar Avenue
Memphis, TN 38197
800-242-2148

Hammermill’s free brochure, Your Guide to the 
Exciting World of Digital Electronic Imaging, 
reviews information such as color and mono-
chrome digital imaging, electronic digital 
prepress, and digital proofs.

NEENAH PAPER
800-558-5061

Neenah’s Classic Columns Text and Cover Print-
ability Guide and Ample Sample 2 provide abun-
dant examples of printing applications from 
invitations to conference brochures.

OCÉ-USA, INC.
1800 Bruning Drive W.
Itasca, IL 60143
800-247-5431

The company produces ink jet, laser printer, 
thermal transfer printer, and color copier papers 
and transparencies for a wide range of printers.

S.D. WARREN COMPANY
225 Franklin Street
Boston, MA 02110
617-423-7300

S.D. Warren, whose Somerset recycled is used in 
the Canvas 5 printed documentation, produces 
many fine papers and informative publications 
on printing and pre-press, including The Warren 
Standard, also available as a multimedia CD-
ROM. S.D. Warren also runs the Idea Exchange, 
1-800-882-IDEA, which collects and catalogs all 
types of print publications.
8



INDEX

A
accordion folds 15

addressing 15

ambient light 37

Apple LaserWriter Properties 
dialog box 44

art 20
continuous-tone 22
line 22
raster 22

artwork 17

ASCII 47

autotracing 20, 22

B
Binary file format 47

binding 14, 15
adhesive 16
edition 16
mechanical binding 16
perfect binding 16
saddle-stitch 16
side-stitch 16

black 26, 32

black and white 22

black generation 52

black ink limit 52

black text 24

blue 31

booklets 16

books 12, 15

bottles, printing on 13

bronze 30

business envelope 15

C
Canvas 7, 14, 22

Canvas document 14

catalogs 13, 15

Center on Paper print 
option 54

choke trap 34

Choose Imagesetter option 43

Chooser 46

CIE-LAB color values 51

cloth 13

CMYK 26, 27

CMYK gamut 28, 38

CMYK inks 22, 30

CMYK Preview command 39

coated paper 19, 29, 30

coated stock 51

color
hi-fidelity 29
HSL 28
in images 17
primary 17, 24
printing 17
process colors 27
separation 24
spot color 24, 30
spot colors 17
subtractive primary 26
types for printing 17

color correction 20

colored paper 30

colorimeter 51

Color manager 29

color matching systems 30

color monitors (computer) 30

Color Printing Guide 19

color separations 17, 24, 25, 
28, 31, 46

Color Separations 
command 46, 51, 52

computer system 22

continuous-tone art 22

copper 30

covers 16
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currency 13

custom page size 42, 43

cyan 26

D
desktop printers 40

resolution 50

diagrams 20

die cutting 12

digital art 22

digital camera 20

digital images 20

digital information 20

digital prepress 18

digital publication files 14

display modes 38

Document Setup 
command 14

dot gain 51

dot pattern (halftone) 18

dots per inch 20

dpi 20

E
edition binding 16

embossing 12

envelope 15

F
facing-page spreads 14

Filename.map file 41

fill inks 25

film 24

film negatives 14, 19

film separations 25

fluorescent ink 30

folders 15

folding 15

folds 15

font inclusion in PostScript 
files 48

form 14

four-color printing 26

G
gamma values 37

Gamut Warning color 38

Gamut Warning command 38

glass 13

glass halftone screen 18

gold 30

gravure 9, 13

grayscale 23

greeting cards 15

H
halftone dot 18

halftone images 27

halftone patterns 19

halftones 17, 18

halftone screen angles 50

halftone screen frequency 18, 
19, 20, 21, 50

halftone screening 17, 18, 27, 
30

hard covers 16

High-fidelity color 29

holes (punched) 16

hot foil stamping 12

HSL color 28

hues 26

human eye 28

I
image reproduction 17

images
memory requirements 23
pixel-based 22
sources 17

images, enlarged 21

imagesetter 21

imposition 14

imposition software 14

impression roller 13

ink 10, 13
CMYK 30
fluorescent 30
metallic 30
pre-mixed 30
process colors 28
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ink limits 52

inks
CMYK 22
fill and pen 25

Inks palette 24, 29, 30

insertion equipment 15

Internet Protocol networks 47

interpolation 22

invitations 15

J
journals 16

K
knockout 31

knockouts 17, 31, 34

L
laser printers 20

LaserWriter 7 printer driver 43

LaserWriter 8 printer driver 42

layers 25

leather 13

letter 15

letterpress 9

light 26

lightness 28

line art 20, 22

line screen 18

lines per inch 18

lithograph 10

lithography 9

loose-leaf notebooks 16

lpi 18

M
magazines 13, 19

magenta 24, 26

mechanical binding 16

memory 21

memory requirements 23

metallic ink 30

mirror image 45

misregistration 30

Monitor calibration 36

Monitor Setup command 36

monitor setup files 37

N
names, spot color 24

negative output 43, 45

newsletters 14, 30

newspapers 14, 19

newspaper supplements 13

newsprint 19, 31, 51

notebook 16

O
Object Info command 34

Object Info palette 33, 34

offset lithography 10

on-line Help 7

Options tab 33, 34

orange 27, 30

out-of-gamut colors 38

Overprint Black option 33

Overprint command 33

overprinting 17, 31

overprinting black 50

Overprint Object option 33

P
packaging 15

page margin 16

Page Setup command 42, 46

paintings 22

pamphlets 14

Pantone 24

Pantone, Inc. 30

PANTONE Matching 
System 30

paper 19, 31

paper, coated 19

paperback books 16

paper size 42

parallel folds 15

pen-and-ink diagrams 22

pencil sketches 22

pen inks 25

perfect binding 16

phosphor 37

Photo CD 22

photographs 17, 18, 20

photosensitive emulsion 10, 
13

pixel-based image 22

pixel information 21
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pixels 20

pixels per inch 20

platemaking 14

Pocket Pal 56

positive film 13

PostScript Printer Description 
(PPD) 40

PostScript printer files 14

PostScript separation files 46, 
48

PostScript Setup dialog 
box 43

pre-mixed ink 30

press sheet 14

primary colors 17, 24, 26

Print command 47

printer’s marks 49

Printers control panel 46

Printer Setup command 41, 
44, 46

printing 25
four-color 26
process color 26

Printing Inks command 46, 51

printing methods 9

printing plate 24

printing plates 10, 13, 14, 18, 
24, 27, 31

alignment 9

printing press 17, 25, 26, 30

printing presses 13
color 11
offset 11
perfecting 9
screen 13
sheet-fed 9
web 9, 15, 31
web offset 19

printing units 27

Print plates in color option 50

print preview 48

process colors 17, 22, 24, 27, 
28

process printing 26

programs 16

proofing 24, 25, 29

publication files, digital 14

R
rainbow 26

raster art 22

reader’s spreads 14

red 24

reflective art 22

registration 31, 34

resolution 17, 19, 20, 21, 23

resolution (image), ratio to 
halftone screen 
frequency 21

resolution, output device 20

RGB colors 22

right-angle folds 15

road map 15

rosette pattern 27

rubber stamp 12

S
saddle stitching 16

saturation 28

scanners 20

scanning 17, 19

scanning service 20

screen angle 45

screen frequency 45

screen printing 9

screen resolution 18

screen ruling 18

separating colors 24

separations 21, 46
film 25

Separation Setup dialog 
box 33, 34, 49

Separation Tables 
command 46, 53

side stitching 16

signatures 14, 16

silk screening 13

silver 30

Skip Blank Pages option 47

spectrophotometer 51

spectrum 26

spines 16

spot color 17, 24, 25, 30
converting to process 

colors 49
names 24

Spread command 34

spread trap 34

stamps 13

Standard Web Offset Press 
(SWOP) 51

staples 16
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stencil 13

stripping 14

Style submenu 33

subtractive primary 26

T
text 32

textbooks 16

TIFF 22

Tile printing option 54

tonal range 20

Toyo 24, 30

transmission art 22

Trap Object option 34

trapping 11, 17, 34

trap size 34

trimming 15

Trumatch 29

Trumatch Colorfinder 29

U
uncoated paper 30

V
varnish 25, 27

vector illustration 22

W
wallpaper 13

watercolors 22

web offset presses 19

wetting solution 10

white point 37

wire spirals 16

wire staples 16

wood 13

Y
yellow 24, 26
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